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1. Creating your first PCSWMM model 

This is a basic introduction to modeling with PCSWMM. 

For instructions on how to use the PCSWMM workbook features, please refer to the 
following article and video. This exercise does not require you to download any files. 

1.1 Setting up a new PCSWMM model 

1. To begin with let's create a SWMM5 project: 

2. Launch PCSWMM and click the New button located on the left side of the opening 
screen. 

3. Select SWMM5 Project from the list of new projects. 

 

4. In the Name box write My first model. 

 

https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=111&ChapterNum=1&ScheduleID=134&WorkbookID=15&License=837645&Email=jin@hydrosoft.co.kr&v=EqZc2R4A316goBtYmFrs2nHFMENZjh3pI28eFtjRhbaqUWIjSfEO08gP5e%2bufDH1Ha4E0DqSFUNb2XEgf%2fNQ08z0i2spVsAxbxXAnlqcwIFA9i3akOMxFyiICD3%2fguzh0ab00uXaOYXtxXgdaq0J4RJHdyu%2bU2SMxvCeTC40fyEto2OmIM9YCpYkgeOqBHfCsf96b0JCelRGGijKLKjeWEZ9wgi%2f9RCDMIcyhrsLhWGYYxBNz5eVw5%2fQESFS2PgCP91u80ZtK7GSTh0394jj8bay8MQ2VW2Di%2bBJcicUjPZP9O3E%2fhLecqIXfVFbbBKJ
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5. In the Location box browse to a known location and click OK. 

6. In the Abbreviation box write Model1. 

7. Click the Create Project button. 

Note: You also have the option to add project notes when creating a project. You 
can then further edit or append the notes with additional information or a list of 
tasks at any time using the Project Notes tab in the Attributes panel. Since this 
example will be located in New York we will begin by setting the project to use US 
units. If you are working in the United States you can skip this step as your flow units 
should automatically be set to CFS. 

8. Click on Simulation Options from the Project panel. 

9. In the General tab in the Simulation Options editor change the Flow units to CFS. 

10. Click on the OK button. 

11. Click on the Switch button when asked. 

1.2 Opening background layers 

Let's choose a background layer to provide reference for our New York City model. If we had 
GIS layers for this area we could open them, however for this exercise we are going to use 
the open source Bing Maps. 

1. In the Layers panel click on the Tile Map Service Selector that says "None" (located 
in the bottom left corner of PCSWMM). 

 

2. Select Bing map roads from the list. 
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3. Click on the Zoom  button, or your mouse scroll wheel, and zoom into the 
approximate location of New York City. 

 

4. Continue to zoom into the location of New York City (Lower Manhattan) as shown in 
the screenshots. 
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5. Continue to use the Zoom  function, or alternately use the mouse scroll wheel, to 
zoom into the location shown in the screenshots provided: the Governor Nelson A. 
Rockefeller Park, south of the Holland Tunnel and East of the West Side Hwy (9A). 

 

 

1.3 Creating a SWMM5 model 

1. Click on the Outfalls layer in the Layers panel. It will appear grayed out as there are 
currently no Outfall entities. 

2. Click on the Add  button in the Map panel. 

3. Click to add an outfall located on the shore linear to Murray street, as shown in the 
screenshot provided. 
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4. We will now add a junction that will act as the outlet for the subcatchment runoff. 

5. Click on the junctions layer in the Layers panel to select the Junctions layer. 

6. Click on the Add  button and click on the intersection of Murray St and North End 
Ave, as shown in screenshot provided. 

 

7. We will now connect the two nodes (outfall and junction) with a conduit. 

8. Click on the Conduits layer in the Layers panel and click on the Add  button. 

9. The conduit flow direction is based on the order you draw the link (upstream to 
downstream). Click on the Junction and then click on the Outfall to draw the 
conduit connecting these two entities. 
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10. A message will appear asking if you want to estimate the conduit lengths from the 
map, click on the Yes button. 

 

11. If you look at the Attributes panel (on the right of the PCSWMM window) you should 
see the Length attribute of the selected conduit has been assigned the map length. 

12. Now we will parameterize the SWMM5 entities. 

13. Click on the Select  button to get out of Add mode 

14. Click on the Outfall to select it and, in the Attributes panel, set the Rim Elev. to 10 ft. 
The invert elevation (Invert El.) will be left at 0 (sea level). 

15. Click on the Junction and assign it an Invert elevation of 10 ft and a Depth of 10 ft. 

Note: You can only edit one of Depth or Rim Elev. (the other will be calculated). If 
the Depth attribute is being calculated (i.e. is disabled), select the Depth attribute 

and click on the Expression  button that appears in the value field. In the Auto-
expression editor, click on the Calculate Rim Elev. instead button.  

16. Select the Conduit and change the Roughness to 0.014 and the Diameter 
or Geom1 to 2 ft. 

17. Now we will add a subcatchment. 

18. Click on the Subcatchments layer in the Layers panel. 
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19. Click on the Add  button and draw a subcatchment outlining the Murray St / 
Warren St block as shown in the screenshot provided. Subcatchments are drawn by 
clicking at the desired vertex locations in the Map panel. 

 

20. Click on the Commit Changes  button or press the Enter key to finish editing the 
subcatchment. 

21. Click on the Select  button to get out of Edit mode. 

22. In the Attributes panel for the selected subcatchment, change the Imperv. attribute 
(directly connected impervious area) to 50%. 

23. You should notice the Area of the subcatchment was automatically assigned as we 
asked the program to use map measurements. For the sake of brevity, we will skip 
parameterizing the other Subcatchment attributes (see our other exercises for more 
details on this). 

1.4 Assigning rainfall and running the model 

1. The next step is to assign rainfall input to the subcatchment. For this step we will be 
using a design storm event from the design storm creator tool. 

2. Click on the Graph tab (along the top of the PCSWMM window) to switch to 
the Graph panel. 

3. In the Graph panel, on the Add  button to add a new design storm. 

4. Select an SCS type design storm. Choose Type II, set the Total rainfall to 5 in., set the 
storm duration to 24 hours and change the Rain interval to be 6 min. 

5. Click on the Create Time Series & Setup Model button. 
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6. PCSWMM created the time series in the Time Series Manager (on the left side of the 
Graph panel) and setup the model. In setting up the model, PCSWMM inserted the 
time series as a SWMM5 time series object, created a SWMM5 rain gage object 
linked to this SWMM5 time series object, assigned the rain gage to the 
subcatchment, and setup the simulation period to match the time series dates. 
Now your model is ready to be run. 

7. Click on the Run  button located in the Project panel 

1.5 Viewing results 

Once your model has successfully ran you will see continuity errors displayed at the bottom 
right side of the screen. These values will be rendered from Green to Red depending on the 
size of the error. Generally you want these boxes to be green as that indicates that your 
runoff and routing errors are below 1%. You may also notice a Flooding warning, which 
indicates surface flooding (usually from an undersized conduit). We'll discuss how to remedy 
the flooding later. 

1. Click on the Runoff or Routing error boxes in the bottom status bar (or click on 
the Status tab and choose the Continuity Errors section) to view the mass balance 
report in the Status panel. 

2. Review the water balance from the status report to ensure the values seem 
reasonable. 

3. Now let's plot the hydrograph through the conduit. 

4. Click on the Graph tab to switch to the Graph panel. 

5. In the Time series manager, select SWMM5 output > Links > Flow > C1 (put a check 
beside C1). Use your mouse to zoom into the hydrograph by holding down the left 
mouse button and dragging over the portion of the graph you want to see. 
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Congratulations, you've successfully completed your first PCSWMM model! To familiarize 
yourself with SWMM5 model output, we recommend you browse through the Status 
panel result tables, examine the result attributes of the entities in the Map panel, and explore 
the other time series generated by SWMM in the Graph panel. 

You can also experiment by adding more junctions, conduits and subcatchments, as well as 
perform sensitivity tests on the various subcatchment attributes by adjusting them and re-
running the model. 

For more hands-on exercises, please refer to your General Workbook, located under My 
Training in the Help tab (File > Help > My Training). 
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2. Design of a new stormwater system 
with pipe-sizing and junction drops 
and losses (Valleyfield, Quebec) 

This exercise illustrates the design of an urban residential stormwater drainage system using 
PCSWMM. In this example, we develop from scratch a preliminary design for a new 
stormwater drainage system. The system comprises catch basins, manholes and pipes - 
capable of handling the 10y design storm - for a new development of approximately 80 
single-family detached residences in Valleyfield, Quebec. Pipe-sizing and junction drops and 
losses are included. 

 

2.1 Setting up a new SWMM project 

Let’s begin by setting up a new SWMM5 project for the preliminary design: 

1. In PCSWMM, create a new SWMM5 project named Valleyfield to-be minor in 
the PCSWMM Exercises\K018\Initial folder. 

2. Launch PCSWMM and click the New button located on the left side of the opening 
screen under File. 

 

https://www.youtube.com/embed/DqwzL9I0R4c
https://www.youtube.com/embed/DqwzL9I0R4c
https://www.youtube.com/embed/DqwzL9I0R4c
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3. Select SWMM5 Project from the list of new projects. 

 

4. In the Name box write Valleyfield to-be minor. 

5. In the Location box browse to the PCSWMM Exercises\K018\Initial folder and 
click OK. 

6. Click the Create Project button. 

7. Open  up the photo-grand-ile.jpg background layer from the PCSWMM 
Exercises\K018\Initial folder. 

8. Click the Open  button in the Map panel. 

9. Click on the Open  button in the top right corner of the Layer browser. 

 

10. Navigate to PCSWMM Exercises\K018\Initial, select the raster image photo-grande-
ile.jpg and click Open. 

11. A message may pop-up asking you to set the coordinate system. If asked, 
select Unknown (m) from the list of options. 

Note: The order of appearance of the layers in the Layer panel dictates their 
hierarchy in the Map panel. SWMM layers are on top of background layers as 



16 

 

default. To arrange the layers, simply drag and drop the layer to its desired position 
in the Layers panel. 

In the satellite photo we see the St. Lawrence River and Seaway to the north. The 
new development is in the lower portion of the photo, south of the hydro-electric 
servitude ("hydro-cut" – appearing in the photo as a deforested corridor running 
east-west), immediately west of the existing residential area and somewhat north-
east of the quarry. Zoom into this area: 

12. Use the Zoom  button in the toolbar to drag a selection box over the area you 
wish to view, or zoom and pan. In this example we will be zooming into the bottom 
middle of the image (refer to the figure). 

 

13. Click on the Select  button to exit zoom mode. 

14. A CAD file has been prepared showing the location of roads and the proposed 
residential lots. To overlay this file on top of the satellite image, we will simply open 
the file. 

15. Open the H64020_r14_Residential.dxf in the PCSWMM Exercises\K018\Initial folder. 

16. Click the Open  button in the Map panel. 

17. Click on the Open button and select the AutoCAD 
file H64020_r14_Residential.dxf (in the folder PCSWMM Exercises\K018\Initial) 

18. Click Open.  

The CAD drawing will appear in the Map panel delineating the lots and roadways in yellow. 

For this exercise we need to develop the minor system drainage network that will convey the 
10 year storm water runoff from all lots and roads. The area is relatively flat and must be 
graded to ensure that minimum slopes are achieved. Thus the invert elevation has been 
provided for the outfall at the ditch and manhole invert elevations will be calculated in the 
model from the minimum required slope for all pipes. 
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2.2 Changing the infiltration method 

Change the infiltration method to Green-Ampt in the Simulation Options. 

In the Project panel click on Simulation Options. 

In the General tab, under the Infiltration model section, select Green-Ampt (if it is not already 
selected) and click OK. 

 

2.3 Rendering SWMM5 entity labels and turn on link arrows 

In this section we will be setting up the labeling for each of the outfalls, junctions and 
conduits using the Rendering menu. These labels will not show up in the map panel until after 
an entity has been added. 

1. Set up the Outfalls layer to display a label with the Name showing and a red back 
color. 

2. Click the Render  button in the toolbar of the Map panel. 

3. Select the Outfalls layer from the list of layers. 

4. Click on the Label button on the right side of the Layers properties manager. 

5. Click on the Insert button and select Name from the list of attributes and click Insert. 

6. Change the Back color to red, located under the Expression box. 

7. Click on the Apply button. 
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Now we are going to do the same thing for the Junctions and Conduits layers. 

8. Set up the Junctions layer to display a label with the Name showing and a blue 
back color. 

9. With the Layer properties manager still open, click on the Junctions layer in the list of 
layers. 

10. Click on the Label button. 

11. Click on the Insert button and select Name from the list of attributes and click Insert. 

12. Change the Back color to light blue, located under the Expression box. 

13. Click on the Apply button. 

14. Set up the Conduits layer to display a label with the Name showing and a yellow 
back color. 

15. Click on the Conduits layer in the list of layers. 

16. Click on the Label button. 

17. Click on the Insert button and select Name from the list of attributes and click Insert. 

18. The Back color should be set to yellow by default so we will leave it. 

19. Click on the Apply button and click on the Close button.  

Note that you will not see any changes in the Map panel at this point as we have not added 
any entities. Once we start drawing entities, they will have a name label and the back colors 
we defined above. Now we are going to turn on the link arrows in order to see the direction 
of flow in the Conduits. 

20. In the Preferences dialog, turn on link arrows in the Map panel and choose 
to Calculate node depth. 

21. Click on the Menu  button in the Map panel and select Preferences. 
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22. In the Map tab put a check beside Show link arrows. 

23. In the General tab make sure there is a check beside Calculate node depth. This will 
allow us to later edit the rim elevations. 

24. Click on the OK button to close the Preferences.  

2.4 Locating the outfall and manholes (junctions) 

To begin with, we will locate the outfall and the manholes in the network, using a maximum 
distance of 500 ft | 160 m between manholes, and ensuring the placement of a manhole at 
every intersection and change in pipe direction. Generally always start by placing the 
outfall. 

1. Add an Outfall in the location shown in the screenshot attached. 

2. Click the Outfalls item in the Layers panel to make this layer active in the Map 
panel. 

3. Click the Add  button in the toolbar. 

4. Now click at the location you wish to place the outfall (see screenshot below). 

5. Click the Select  button in the toolbar to exit add mode. 

6. Once the outfall is added and selected (highlighted in blue), we can edit the 
attributes. 

 

7. In the Attributes panel (on the right side), change the Name to Outfall and 
the Invert El. to 149.61 (ft) | 45.6 (m). 

We will be positioning the junctions according to a GIS background layer provided. 

8. Open the Junctions outline.SHP file in the PCSWMM Exercises\K018\Initial folder. 

9. Click the Open  button in the Map panel. 
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10. Click on the Open button in the top right corner of the Layer browser. 

Navigate to the folder PCSWMM Exercises\K018\Initial, select Junctions outline.SHP and 
click Open.  

A pop-up may appear asking you to Set coordinate system, if you received this message, 
select Unknown (m) from the list of options. 

Keep in mind the junctions outline layer is just a background layer and does not represent 
actual SWMM5 junctions. 

We will now turn on Auto-Length. This option will use the GIS map lengths to estimate the 
length and areas of conduits and subcatchments as opposed to using the default length. 

11. Click on the Auto-Length box located in the status bar at the bottom of the 
PCSWMM window and select On. 

 

12. Add junctions and conduits based on the Junctions outline.shp file. Use the 
attached screenshot as a guide. 

13. Select the Junctions layer from the Layers panel. The Junctions layer will appear 
gray as there are no junctions in the model yet. Be careful not to select the 
Junctions outline layer. 

14. Click the Add  button in the toolbar. 

15. Click on J1 on the background layer and then, holding down the Shift key, click 
on J2. Notice how by holding down the Shift key, a conduit is automatically created 
connecting the two junctions. 

16. While still holding the Shift key click on J3 and J4. 
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17. Now release the Shift key and click on J5. 

18. Now hold down the Shift key and click J6, J7, and J8. 

19. Once again release the Shift key and click on J9. 

20. Now hold down the Shift key and click on J4, J8 and finally the Outfall. PCSWMM will 
recognize there is already a junction at the J4 and J8 locations and connect the 
network automatically. 

Note: If you don't hold down the Shift key a conduit won't be automatically drawn to 
connect the junctions. If this happens you can add a conduit by clicking on the 
Conduits layer, clicking on the Add button and clicking the upstream and downstream 

nodes. If you make a mistake, switch back to the Select  button, select the entity and 

click the Delete  button in the toolbar or press the Delete key on the keyboard to 

delete the junction. Then you can return to the Add  button and continue adding 
manholes. It will be easier later if you rename some of the nodes to reflect the figure 
below. 

  

21. Click the Select  button in the toolbar to exit Add mode. 

22. Check that the conduit flow directions match the screenshot above. If you need to 
change the direction of a conduit click on the conduit, right click and 
select Reverse link. 

23. Since we no longer need the junctions outline template, it can be closed. 

24. Select the Junctions outline layer from the Layers panel and click 

the Close  button. 

25. In the Table panel, filter the Junctions layer to display only Name and Rim Elevation. 
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26. Click the Table tab to open the Table panel. 

27. Ensure that the Junctions layer is selected in the Layers list. 

28. Click on the Filter  button and check then un-check the Select all box at the 
bottom. 

29. Place a check beside Name and Rim Elev. and click on the Apply button. 

 

The Table panel should only be displaying the name and rim elevation attributes for junctions. 

Enter the Rim Elev. values from the image below (click on the image icon to see the table). 
Please note this image has been altered to show both metric and US units; this is not 
automatically shown in PCSWMM. 

Note: In PCSWMM, the Junction depth can be defined either by setting the Depth of the 
junction or by setting the Rim Elevation. Often when creating a model of a subdivision the 
Junction depths are unknown, however by defining the elevation of the rim, the depth can 
be automatically calculated by subtracting the Invert Elevation from the Rim Elevation. If the 
Rim Elev. attribute is being calculated (i.e. is disabled), select the Depth attribute and click 

on the Expression  button that appears in the value field. In the Auto-expression editor, 
click on the Calculate Depth instead button and vise versa. 

 

30. Click the Save  button. 
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2.5 Setting conduit attributes 

1. Return to the Map panel by clicking on the Map tab. 

2. Select all the conduits. 

3. Click the Conduits layer in the Layers panel. 

4. Select all of the conduits by pressing the Ctrl + A buttons on the keyboard.  

5. Change the attributes for all the conduits as follows: 

Roughness = 0.013 

Cross-Section = CIRCULAR 

Geom1 = 3.5 (ft) | 1 (m) 

Now we need to assign invert elevations for all manholes in the system. As we need to meet 
a pipe slope criteria of at least 0.25% and the outfall invert elevation is 149.61 (ft) | 45.6 (m), 
PCSWMM can calculate the required invert elevations of all the other manholes in the 
drainage network. 

6. Using the Set Slope tool, set the slope to 0.25%. Preserve node rim elevations and 
raise upstream nodes' invert elevation. 

7. Click on the Tools  button. 

8. In the Conduits section, click on the Set Slope tool. 

9. In the Set Slope tool, in the Set slope box, enter in 0.25 (%) 

10. Check the box to Preserve node rim elevations. 

11. Check the box to Raise upstream nodes' invert elevation. 

12. Uncheck the box to Apply to flatter conduits only. 

13. Click on the Analyze… button. 

 

A table of calculated changes will appear for review.  
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14. Click Apply to implement them, and then on the Close button. (Please note the 
screenshot shown is in US units. In addition, the values presented below may differ 
based on how exact the conduits were drawn). 

 

Note: If all 9 nodes are not listed in the Set Slope tool, it may be because the flow direction is 

incorrect. Under the Menu  button in the Map panel select Preferences. In the Map tab, 
click the box next to Show link arrows to turn on the feature if it is not already turned on. 
Click OK to close. From there select the conduits that are not in the upstream direction and 
right-click and select Reverse link. 

15. Select a pathway from J1 to the Outfall and open the Profile panel. 

16. In the Map panel, click on junction J1. 

17. Hold the Shift key down and click on the Outfall. A path of connecting entities 
should be selected. 

18. Click the Profile tab view the profile.  

19. Display the rim elevations and pipe diameters in the Profile.  

 

20. Click the Properties  button in the Profile panel. 
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21. In the Profile Properties editor, under the Node section, ensure Rim elevation is 
checked. 

22. In the Link section, ensure Depth is checked. 

23. Click the Close button to exit the Profile properties. 

The profile should appear similar to the screenshot shown. 

 

2.6 Importing subcatchments 

1. We are now going to import subcatchments from an external GIS layer. 

Subcatchments can also be manually added using the Add  button in the Map 
panel; the way the junctions and conduits were added. 

2. Import subcatchments from the Subcatchments outline.shp file in the PCSWMM 
Exercises\K018\Initial folder using the Import GIS/CAD wizard. 

3. Click on the File tab. 

4. Click on Import and select GIS/CAD . 

5. Click on the Subcatchments item. 

6. Click on the Browse… button and navigate to PCSWMM 
Exercises\K018\Initial and select Subcatchments outline.SHP. Since it was a 
previously created subcatchment layer, the importer will recognize the attributes 
and automatically match them up. 

7. Click on the Finish button. An import report will appear. 

8. Click the Close button.  

9. The subcatchments will appear in the Map panel. 
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2.7 Assigning subcatchment parameters 

Now the subcatchment parameters can be assigned. Subcatchment parameters are given 
in this example, however values for many of the parameters listed below can be found on 
the PCSWMM support site in the Reference Tables section. In addition, land use and soil 
layers can be used to area weight infiltration and imperviousness values from GIS polygons 
using the Spatial Weighting tool in PCSWMM, however this is covered in another exercise 
(Estimating subcatchment attributes based on land-use and soils layers). 

1. Select all the subcatchments. 

2. Click on the Subcatchments layer from the Layers panel. 

3. Press the Ctrl + A keys on the keyboard to select all subcatchments.  

4. Set the following attributes for all subcatchments in the Attributes panel (screenshot 
is also attached). 

 

https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=18&ChapterNum=2&ScheduleID=134&WorkbookID=15&License=837645&Email=jin@hydrosoft.co.kr&v=EqZc2R4A316goBtYmFrs2nHFMENZjh3pI28eFtjRhbaqUWIjSfEO08gP5e%2bufDH1Ha4E0DqSFUNb2XEgf%2fNQ08z0i2spVsAxbxXAnlqcwIFA9i3akOMxFyiICD3%2fguzh0ab00uXaOYXtxXgdaq0J4RJHdyu%2bU2SMxvCeTC40fyEto2OmIM9YCpYkgeOqBHfCsf96b0JCelRGGijKLKjeWEZ9wgi%2f9RCDMIcyhrsLhWGYYxBNz5eVw5%2fQESFS2PgCP91u80ZtK7GSTh0394jj8bay8MQ2VW2Di%2bBJcicUjPZP9O3E%2fhLecqIXfVFbbBKJ
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We will now compute the Width attribute for the subcatchments by dividing each 
subcatchment area by an approximate maximum length of overland flow (flow length).  

This is not the real width of the subcatchment.  

We’ll assume the average maximum length of overland flow is the sum of the average lot 
depth (115 ft | 35 m) plus the curb length between catch basins (197 ft | 60 m), which 
equals 312 ft | 95 m. 

5. Using the Set Flow Length/Width tool, set a fixed length of 312 ft | 95 m for the 
subcatchments. 

6. Click on the Tools  button. 

7. In the Subcatchments section, click on the Set Flow Length/Width tool. 

8. Select Fixed length in the dialog and enter 312 ft | 95 m in the text box (please note 
the screenshot shown is in SI units, US units will differ). 
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9. Click Apply to execute it. 

10. Examine the log of changes and click Close. 

11. Switch to the Table panel by clicking on the Table tab. 

12. Select the Subcatchments layer if the subcatchments layer is not already selected. 
You should see the new width values for each subcatchment (please note the 
screenshot shown is in SI units, US units will differ). 

 

2.8 Adding a design storm as a rainfall time-series 

Now for this simple, straight-forward stormwater minor system design, the next step is to 
specify a minor design storm suitable for pipe sizing. For this exercise we will use the design 
storm creator tool and automate the project time series setup. To generate a design storm 
time series: 

1. Click on the Graph tab to open the Graph panel. 

2. Click on the Add  button to open the Design Storm Creator. 

3. Select AES. 

4. Change the Type to Southwest Quebec from the list. 

5. In the Total rainfall box type in 1.5 in| 36 mm 

6. Ensure the Rain format is set to Intensity. 
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7. Click on the Create Time Series & Setup Model. This will automatically create your 
rain gage, assign it to all of the subcatchments and change the duration of your 
model to match the rainfall time series. 

8. Click on the Map tab to return to the Map panel. 

2.9 Running the model 

1. In the Map panel, click on Simulation Options in the Project panel. 

2. Click on the Dates tab, and change the Duration (h) to 3 and click OK. 

 

3. Click the Run  button in the toolbar to save the project and run a simulation. If 
the run is successful, a pop-up window will show the message, ‘Run was successful’, 
with Continuity Error information. 
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4. Check that the continuity errors are reasonable (say less than 5%, depending on the 
design accuracy required). 

It may seem counter-intuitive, but drops and losses are assigned after the pipes are sized. This 
is because pipe sizing uses the Manning’s formula which does not take into account 
manhole drops. In addition, minimum pipe drops need to be assigned after the pipes are 
sized so this suggested sequence saves repeating steps. Once the drops are added and the 
model rerun, the pipe capacity results should be checked, along with the profiles, and pipe 
sizes tweaked as necessary. Although the sequence of steps suggested here is more efficient, 
there is, however, no harm in assigning drops and losses before the pipes are sized, and then 
executing the drops and losses tool after the pipes are sized. 

2.10 Sizing the pipe diameters 

PCSWMM will compute the minimum circular pipe diameter that will not flow full, provide the 
nearest standard pipe diameter, and apply them to the model (i.e. update the input data 
file accordingly). Note that this capability only applies to circular pipes. The program uses the 
Manning's formula to compute the diameter: 

  

Manning’s n and slope S are conduit attributes entered by the user, but flow Q is computed 
by the model. If the initial pipe size is too small, the required free flow cannot be computed. 
Therefore, users must initially oversize the pipes in order for PCSWMM to compute the best 
standard pipe diameters. 

1. Select all the conduits. 

2. While still in the Map panel, select the Conduits layer in the Layers panel. 

3. Press the Ctrl + A keys to select all of the entities.  

4. Use the Pipe sizing tool to set a minimum diameter of 1 ft | 0.3 m. Choose to 
preserve crown elevations, adjust node invert elevations and preserve rim 
elevations. 

5. Click on the Tools  button. 

6. In the Conduits section, click on the Pipe Sizing tool. 

7. In the Pipe Sizing tool, set the Minimum diameter to 1 ft | 0.3 m. 

8. Select the option to Preserve pipe: Crown elevations. 

9. Place a check in the Adjust node invert elevations to match lowest connected 
pipe option. 

10. Check the option to Preserve node rim elevations. 
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11. Click the Analyze button (please note the screenshot shown is in SI units, US units will 
differ).  

12. Compare Original Diameter and New Diameter in the Pipe Sizing preview. Click on 
the Nodes tab to see the computed changes to the invert elevations due to pipe 
resizing. 

13. Click Apply to implement the changes and click on the Close button to exit 
the Pipe Sizing tool and see the adjusted pipe diameters in the Profile panel. 

2.11 Setting drops/losses 

Now we need to adjust the drops across each manhole to take into account bend angles in 
SWMM, since the engine does not consider them. In this example, we will assign a drop of 0.1 
(ft) | 0.03 (m) to have a loss coefficient of 0.15 for a straight-through pass (bends less than 15 
degrees). And we will assign a drop of 0.49 (ft) | 0.15 (m) to have a loss coefficient of 1 for a 
45 to 90 degree bend at a manhole. The bends at nodes J4 and J8 are greater than 90 
degrees and so we will have 45 degree elbows installed immediately upstream (these elbows 
may not meet specs in your area and are not explicitly modeled for this preliminary design). 

 

For this process; 

Use the Set Drops/Losses tool to set both drops and losses as shown in the following 
screenshots. 

1. In the Map panel click on the Tools  button. 
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2. In the Conduits section, click on the Set Drops/Losses tool. 

3. In the Calculate drop-down menu, select Both drops and losses (should be default). 

4. Enter the Angle, Drop and Loss Coef. values as shown in the images, ensuring the 
units are correct.  

SI units 

 

US Units 

 

5. Check the Apply as minimum criteria, Preserve conduit slopes, and Preserve node 
rim elevations options. 

6. Click Analyze. 



33 

 

7. View the Set Drops/Losses report to ensure that the C3, C4 and C5 exit loss 
coefficients are the same (please note the screenshot shown is in SI units, US units 
will differ). 

 

8. Click Apply to apply the changes and then click the Close button. 

9. Click on the Run  button to save the project and regenerate the results. 

After the run completes, you can check the longitudinal profiles throughout the network 
(Profile panel>Menu>Show Peak Values) to ensure the pipes still have sufficient capacity to 
avoid surcharging with this design storm. 

2.12 Viewing and interpreting the results 

1. Clear the current plots in the Graph panel. 

2. Click the Graph tab to open the Graph panel. 

3. Uncheck the AES_1h_Southwest_Quebec_36mm if still plotted in the Graph panel.  

4. Plot the velocity for all links. 

5. In the Time Series Manager, under SWMM5 output, expand Links > Velocity to plot 
the stormwater velocities. 

6. Select all the conduits (from 1 to 9) by right-clicking Velocity and choosing Select 
All from the pop-up menu.  

The Graph panel can also be used to plot the runoff from all subcatchments and flows in all 
the conduits, as well as the depths in all nodes in the system (please note the screenshot 
shown is in SI units, US units will differ). 
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Note: Your plots of velocities should be similar to the above plots. The peak velocities should 
exceed the minimum self-scouring velocities specified by your local approval agency 
(commonly about 2 ft/s | 0.6 m/s). In this design, conduit C9 is a typical dead-end sewer with 
a small runoff area, so care needs to be taken to avoid sedimentation. 

Finally, check the continuity errors reported in the Status panel to ensure that the numerical 
solution is behaving reasonably well. You can also experiment with radically different routing 
time steps (be sure to adjust the report time step accordingly) to examine the numerical 
effects. 

2.13 Bonus: Alternative rainfall using IDF curves 

The following section reviews the required steps for adding a design storm using IDF curves. 
For this example, we will be using IDF curve parameters available from the Windsor/Essex 
Regional Stormwater Management Standards Manual provided by the City of Windsor 
located in Ontario, Canada. 

1. Duplicate the current scenario in the same folder, with the name "Valleyfield IDF", 
the abbreviation "IDF", and the description "Bonus IDF rainfall example". 

2. Click on the Plan  (scenario manager) button in the toolbar of the Project panel 

3. In the Scenario Manager, click on the Add  button and select Duplicate Current 
Project. 

4. In the Create Scenario(s) dialog name the project Valleyfield IDF. 

5. Specify the location where your exercise is located (e.g. PCSWMM 
Exercises\K018\Initial). 

6. Enter in the Abbreviation to be IDF. 

7. Edit the Description (Title) text to read Pre-development peak flow estimation 
(Bonus IDF example). 

8. Click the Create button 

9. Click on the Graph tab to open the Graph panel. 
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10. Click on the Add  button in the Graph panel to open the Design Storm Creator. 

11. Under Type click on Chicago and then select the IDF... button to open the IDF 
Editor. 

12. Click on the Add  button to add a new IDF curve and select abc table from the 
list of options. 

13. Change the name to Windsor_IDF and change the Rain units to mm/hr. 

Enter the numbers presented in the tables below.  

Note: to copy and paste the table directly into the IDF editor, copy the table to Excel, 
highlight the a, b, c values and paste them in the Editor (right mouse button click > paste). 

Return Period a b c 

2 - Year 854 7.0 0.818 

5 - Year 1259 8.8 0.838 

10 - Year 1511 9.5 0.845 

25 - Year 1851 10.2 0.852 

50 - Year 2114 10.6 0.858 

100 - Year 2375 11.0 0.861 

 

Toggle the visible boxes beside each Return Period to see the IDF curves. 

 

14. Click on the 5 year return period by selecting the row from the table and click on 
the Apply abc From Selected Return Period. 

15. Change the Storm duration to 4 h. 
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The Design Storm Creator tool will still be opened and the Chicago Type distribution will be 
selected, displaying the a, b and c values from the 10-year design storm. 

16. Click on the Create Time Series & Setup Model button. 

17. Click on the Map tab to open the Map panel. 

For this model we will be using a fixed stage outfall. Fixed stage outfalls are used to model a 
constant boundary condition. When a fixed stage outfall is used, any upstream junctions with 
invert elevations equal to or less than the fixed stage will have water in them initially. If this is 
not accounted for, instabilities can result causing high routing continuity error values. 

18. Select the outfall and, change the Type to Fixed and set the Fixed Stage to 152.5 
ft |46.5 m. 

19. Click on the Run  button to run a simulation and update the results. 

In the Graph panel, expand the results and plot the new flows in all the conduits (SWMM5 
Output > Links > Flow and right click > Select All). Take note of the backwater flow through 
C8. 
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3. System evaluation using multiple 
return period design storms 

This exercise illustrates how to quickly set up and evaluate model response to multiple design 
storms. 

Stormwater infrastructure design should take into account watershed pre-development 
drainage patterns and watershed boundaries as a strategy to maintain natural site 
conditions. 

In some cases unit relationships are available defining the unit peak flows for a boundary. If 
these are not available, it may be useful to compare the runoff response of the to-be model 
to an as-is model, as demonstrated here. 

Written by request for the Toronto and Region Conservation Authority (TRCA), this chapter is 
based on requirements outlined in Section 3.2 of TRCA’s Stormwater Management Criteria 
Manual and evaluates a new development design using 2, 5, 10, 25, 50 and 100-year design 
storms. 

 

3.1 Opening and grouping as-is and to-be models 

We will begin by linking the pre-development and post-development models as scenarios. 

1. Open the Valleyfield as-is.inp file from the PCSWMM Exercises\K021\Initial folder. 

2. In the File tab, click the Open  button. 

3. Browse and open the project PCSWMM Exercises\K021\Initial and select Valleyfield 
as-is.inp.  

4. A dialog will appear showing a default location to unpackage the model: click on 
the Unpackage button then the OK button.  

https://www.youtube.com/embed/bhpYpLuW4eY
https://www.youtube.com/embed/bhpYpLuW4eY
https://www.youtube.com/embed/bhpYpLuW4eY
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5. Add Valleyfield to-be as a scenario. 

6. Click on the Plan  button in the Project panel to open the Scenario Manager. 

7. In the Scenario Manager, click on the Add  button and choose Add Existing 
Project. 

8. Open the Valleyfield to-be scenario. 

9. Browse to K021\Initial and select Valleyfield to-be.inp then the Open button. 

10. Click the Close button to close the Scenario Manager.  

3.2 Loading design events in the Graph panel 

For this exercise we will be evaluating the pre- and post-development models using multiple 
design storms. Let’s start by creating a 100-y storm. 

1. Click on the Graph tab to open the Graph panel. 

2. Select the Add  button to open the Design Storm Creator. 

3. Select SCS from the list of design storms. 

4. Change the total rainfall to be 3.5 in|90 mm. 

5. Choose a Type II storm and set the Storm duration to 24 hours. 

6. Leave the Rainfall interval set to 15 min and the Rainfall format set to Intensity. 

7. Edit the Name to be 100-Year. 
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8. Click on the Create Time Series button to create the 100-y time series (please note 
the screenshot shown is in SI units, US units will differ). 

 

We will now repeat the steps 2-8 above to create the 50-y, 25-y, 10-y, 5-y 
and 2-y storms using the SCS 24h Type II design storm distribution. The 
table below summarizes the Total rainfall values and Names to be used 
for each storm. 

 

  

3.3 Saving design storms 

We will now save the time series as a single time series file by consolidating the graphed time 
series. 

1. Click the check box next to each design storm time series to plot it in the Graph 
panel if it is not plotted already. 
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2. Click on the Save  button in the Graph panel and select Consolidate. 

 

3. Browse to the K021\Initial folder and name the file Valleyfield design storms.tsb. 
Click Save. 

3.4 Generating return period storm scenarios for to-be model 

In PCSWMM, scenarios can be created using graphed or saved design storms. This allows the 
user to quickly generate multiple scenarios and run them. In order to reduce computational 
time, it is useful to have multiple CPU cores in your computer. The first thing we will do is set up 
PCSWMM to leverage all of the available cores. 

Set PCSWMM to use all of the CPU cores available on your computer. 

1. Open the Map panel, click on the Menu  button and select Preferences... 

2. Click on the Grid tab and change the number of cores being used to the total 
number of cores available on your computer. 
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We will now generate 6 scenarios, one for each design storm. 

3. Click on the Run  button to run the current scenario. 

4. Use the Create Design Storm Scenarios tool to create and run scenarios from the six 
currently graphed time series. 

5. In the Project panel click on the Plan  button. 

6. Click on the Add  button and select Create Design Storm Scenarios from the 
drop-down menu. 

7. In the Create Design Storm Scenarios tool, use the Browse  button and navigate 
to PCSWMM Exercises\K021\Initial and click OK. 

8. Select the Design storm source to be From file and use the Browse  button and 
navigate to PCSWMM Exercises\K021\Initial, select Valleyfield design storms.tsb 
and click OK. 

9. Leave the Simulation period set to Storm+ (0 hrs). 

10. Click on the Create & Run button 

This will create 6 new scenarios and run each one with their corresponding rainfall time series. 
If you have multiple cores, the scenarios will be run in parallel, reducing computational time. 
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3.5 Generating return period storm scenarios for as-is model 

We will now create the design storm scenarios for the as-is model. We first need to switch to 
the as-is model scenario and then repeat the steps above to create the as-is design storm 
scenarios. 

1. Click on the Plan  button in the Project panel to open the Scenario Manager. 

2. In the Scenario Manager, double click on the Valleyfield as-is scenario to open it. 

3. If an option comes up to Save time series, click Save time series. In the Graph 
panel, click the Save  button and choose Save file to save changes to the time 
series. Repeat steps 1 and 2. 

4. If an option comes up to save the project click Save project. 

5. Once the scenario has loaded, click on the Run  button to run the model. 

6. Click on the Plan  button in the Project panel to open the Scenario 
Manager again. 

7. Use the Add  button to create and run 6 design storms scenarios for the as-is 
model using the Valleyfield design storm.tsb file. Refer to steps above in the 
previous section if you get stuck. 

3.6 Recoloring scenarios 

To better understand the results, we will recolor the scenarios to each have a unique color. 

1. Click on File > Manage. 
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The scenarios will be grouped together in the Manage tab. 

Hover on top of the group of scenario tiles until a blue box appears (as shown in the 
screenshot). 

 

2. Click on the Menu  button. 

3. Choose Color by > Sequential. The scenarios will now be re-colored sequentially. 

 

3.7 Evaluating results 

Now that the design storm scenarios have all been created and run, their results can be 
compared with a number of tools in PCSWMM. As an example, we will do a hydrograph 
comparison. 

1. Switch scenarios by clicking on the Plan  button in the Project panel and select 
one of the design storm scenarios. 

2. Switch to the Graph panel. 

3. In the Time series manager, graph Nodes > Total inflow > Outfall. 
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4. Click on the Scenarios  button in the Graph panel. 

5. Add a "to-be" or "as-is" suffix to the design storm depending on which parent 
scenario it came from. Refer to the screenshot. 

 

6. Un-check the current scenario and check both 100 year events (to-be and as-is). 

7. In the Graph panel click on the Objectives tab. 

8. Compare the maximum and total inflows of the to-be model using the Objective 
functions table at the bottom of the screen. 

9. Repeat steps 4-6 to compare each of the remaining design storms (50 year, 25 
year, etc.). 

10. If any revisions to the model are required, make the changes in the original to-be 
scenario and regenerate the design storm scenarios – the existing scenarios will be 
overwritten. 

3.8 References 

Toronto and Region Conservation. 2012. Stormwater Management Criteria Draft. Version 1.0. 
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4. Simple Storage estimation 

This exercise illustrates one method of reducing street flooding by sizing a detention pond to 
attenuate lateral inflow from a subcatchment. 

 

4.1 Open and run the project file 

1. Open Selected Conveyance.inp from the PCSWMM Exercises\K043\Initial folder. 

2. Launch PCSWMM. 

3. Click File and then the Open button. 

4. Browse to the folder PCSWMM Exercises\K043\Initial, select the Selected 
Conveyance.inp file and click the Open button. 

5. Click the Run  button in the toolbar of Project panel. 

4.2 Find surcharging pipes 

1. View the profile from the upper node 80408 to the outfall node 10208. 

2. In the Map panel, click junction 80408. 

3. Hold down the Shift key and select the outfall, 10208. 

4. Click the Profile tab to switch to the Profile panel. 

5. In the Profile panel click on the Menu  button and select Show Peak Values to 
view the peak HGL (hydraulic grade line) for the selected pathway. 

https://www.youtube.com/embed/v9t4CTEBmw8
https://www.youtube.com/embed/v9t4CTEBmw8
https://www.youtube.com/embed/v9t4CTEBmw8
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In this model, conduit 1602 is undersized and causing pipe surcharging and surface flooding 
in the upstream branch of the drainage network. The purpose of this exercise is to try and 
reduce the flooding by inserting an off-line detention pond between subcatchment 1 and 
node 82309 to attenuate the flows coming into the system from subcatchment 1. 

6. Return to the Map panel by clicking the Map tab. 

This approach involves determining the excess capacity of conduit 1602 without the 
contributing runoff from subcatchment 1. A storage pond will be then created for capturing 
the runoff from subcatchment 1, and an outlet will be designed to release a maximum peak 
flow to node 82309 that can be accommodated by conduit 1602. Alternative solutions may 
include digging up and replacing conduit 1602 with a larger diameter pipe, and/or placing 
a cross-connection to the other branch of the system upstream of conduit 1602. 

4.3 Determine excess capacity of a conduit 

To begin with, let’s create a scenario model to work on: 

Duplicate the current scenario, name it Selected Conveyance Scenario, and open it. 

1. Click on the Plan button in the Project panel. 

2. Click on the Add  button and select to Duplicate Current Project . 

3. Name the new scenario Selected Conveyance Scenario. 

4. Click on the Browse button and navigate to Desktop\PCSWMM 
Exercises\K043\Initial. 

5. Click on the Create button. 

6. Click on the Plan  button if the Scenario manager is not already open, select the 
newly created scenario and click on the Open button. 

7. Click the option to Save the current project. 
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Now we will remove subcatchment 1 from the system by directing it to another inlet. In 
the Map panel: 

8. Select the Outfalls layer item in the Layers panel. 

9. Click the Add  button in the toolbar in the Map panel and click in a blank area 
of the map northwest of node 82309. The name of the outfall will be placed as 4. 

 

10. Click the Select  button in the toolbar and select the Subcatchment 1. 

11. In the Attributes panel, change the Outlet attribute value to 4. 

12. Click the Run  button in the toolbar of Project panel to update the results. 
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13. Select the pathway from the upper node 80408 to the outfall node 10208 and click 
the Profile tab to view the new peak HGL without the contributions from 
subcatchment 1. 

Conduit 1602 is almost at peak capacity; however, we should be able to attenuate the flow 
from subcatchment 1 enough with a detention pond to prevent surcharging. 

Now we need to find the maximum hydraulic capacity of conduit 1602 and subtract the 
current peak flow to find the available capacity. 

1. Click the Status tab to switch to Status panel. 

In the Sections list of the Status panel select Cross-sections. The full flow for conduit 1602 
should be 32.5 cfs|0.92 m3/s. 

 

2. Select Link Flows from the list of sections to jump to the Link Flow Summary section, 
you will see Maximum Flow for Conduit 1602 is 35.15 cfs|1.0 m3/s. This 
leaves 2.65 cfs|0.08 m3/s as the maximum allowable contribution from 
subcatchment 1. 

Now we can design our pond and outlet structure. To do this we can apply one of 
the Tools in the Graph panel to compute runoff from subcatchment 1 (i.e. the flow at 
location 1). 

3. Switch to the Graph panel. 

4. Click on the Tools  button and select Storage Pond Calculator. 

5. In the Time Series Manager, expand SWMM5 output > Nodes > Total inflow and 
select the location 4 by clicking on the check box. 

6. In the Storage tab at the bottom of the panel, enter a Maximum design 
outflow value of 2.65 cfs |0.08 m3/s – The part of the Total inflow graph should be 
filled in blue. 

For the sake of this exercise Available storage before outfall will be left at 0 (please note the 
screenshot shown is in US units, SI units will differ). 
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The storage function should report a required storage volume of about 142,709 ft3| 4,024 m3. 
So we now know we need a pond that can store about 142,709 ft3| 4,024 m3 and have a 
maximum outflow of 2.65 cfs|0.08 m3/s at its maximum capacity. 

4.4 Insert a storage pond in the existing model 

We will now insert a storage pond and link it to both subcatchment 1 and node 82309. 

1. Return to the Map panel. 

2. Click the Outfall 4, right click and select to Convert > Storage. 

 

Now add an orifice to connect the storage facility to the drainage system: 
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1. Click the Orifices layer in the Layers panel. 

2. Click the Add  button in the Map panel toolbar. 

3. Draw an orifice link between the new storage node and the existing node 82309. 
This is done by clicking once the upstream node (our storage node 4) and then 
clicking the downstream node (82309). 

4. Click the Select  button in the toolbar to escape from the Add shape mode. 

Now we need to enter the attributes for the storage node and orifice link entities. The 
detention pond will be defined as a constant area pond (a tank) for simplicity. 

5. Click the new storage node 4 to select it and edit its attributes. 

6. Check to see if the Depth attribute is grayed out in the attributes panel. If it is, select 

the Depth attribute and click on the Auto-expression  button that appears in the 
value field. In the Auto-expression editor, click on the Calculate Rim Elev. 
Instead button. 

Update the attributes for storage node 4 as follows: 

Invert El. = 113 (ft) | 34.5 (m) 

Depth = 6.6 (ft) | 2 (m) 

Storage Curve = FUNCTIONAL 

Coefficient = 0 

Constant = 21,623 ft2| 2,012 m2 

For the orifice link, we will use a discharge coefficient of 1 (assuming a smooth round over 
entry for our circular orifice). We will place the orifice at the bottom of our tank, which will 
produce a head of approximately 7m. Using Q=AVK, where V=sqrt(2gh)=~6.3 m/s, we get an 
area of ~0.013 m2 (using A=pi*r2 this gives a diameter of about 0.13 metres). 

7. Click the orifice link in the Map and enter the following attribute values in 
the Attributes panel: 

Type = SIDE 

Shape = CIRCULAR 

Height = 0.42 (ft) | 0.13 (m) 

Width = 0 

Inlet Offset = 0 

Discharge Coeff. = 1 

8. Click the Run  button in the toolbar to save your changes and execute a SWMM 
run. 

After the SWMM run is completed, we are now ready to test this approach. In the Map panel, 

9. Select a pathway from storage node 4 to outfall 10208 and view the HGL (profile). 
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10. Click the Profile tab to switch to the Profile panel. 

11. Click the Play  button to view the peak HGL. 

The peak HGL should not be surcharging. Note the peak flow through the orifice. 

12. Click the Graph tab and expand Nodes > Depth > 4 and Links > Flow > 91001. 

 

4.5 Substitute the orifice with an outlet 

Replace the orifice connecting the storage tank 4 and node 82309. Outlets are used to 
control outflows from the storage tank by its rating curve as a function of the head difference 
across it. 

1. Click on the Map tab to open the Map panel. 

2. Select and right-click orifice 91001 in the Map panel. 

3. In the pop-up menu, choose Convert > Outlets. 

 

4. In the Attributes panel, change the Rating Curve to TABULAR/DEPTH. 

5. Click in the Curve Name textbox and click the ellipsis  button. 

6. Create a new curve by clicking Add in the Rating Curve Editor. 

7. Leave the name as Curve1. 
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Enter data as the outlet discharges no flow when zero head and maximum outflow of the 
storage tank (0.08 m3/s) at the maximum head. Enter the values as shown. 

 

8. Cick the Assign to Outlet91001 button. 

Execute a SWMM5 Run  and check the profile to ensure Conduit 1602 is not surcharging. 
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5. Modeling LIDs (Valleyfield, Quebec) 

Low Impact Development (LID) is a term used to describe a sustainable storm water 
management approach that emphasizes conservation and water quality protection. LIDs 
are becoming more common in new developments and are also being implemented in 
older subdivisions in order to promote infiltration, reduce storm water runoff and improve 
receiving water quality. As such, LID devices are typically used to intercept, store and 
infiltrate some of the rainwater before it reaches the conveyance system. In this exercise we 
illustrate one way of assessing the potential reduction in storm water runoff by modeling a set 
of boulevard planters. 

Multiple LIDs can be placed per subcatchment, and the LID function estimates overflows, 
infiltration flow and evaporation in Rain Barrels, Vegetative Swales, Porous Pavement, Bio 
Retention Cells and Infiltration Trenches. With some limitations, component process layers 
that can be used in each LID include: 

Surface, 

Pavement, 

Soil, 

Storage, and 

Drain. 

Output includes a LID summary in the Status report (.rpt) file and an external report file giving 
computed surface depth, soil moisture, storage depth, surface inflow, evaporation, surface 
infiltration, soil percolation, storage infiltration, surface outflow and the LID continuity error 
(which usually can be reduced by a smaller wet hydrology time step). The time series 
contained in the external report file can also be plotted in PCSWMM. 

 

https://www.youtube.com/embed/wAkfrL4RGvU
https://www.youtube.com/embed/wAkfrL4RGvU
https://www.youtube.com/embed/wAkfrL4RGvU
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5.1 Opening the model 

1. Open Valleyfield to-be.inp from the PCSWMM Exercises\K031\Initial folder. 

Launch PCSWMM. 

2. Click on File and choose Open  from the list of options. 

3. Browse to the folder PCSWMM Exercises\K031\Initial and open Valleyfield to-
be.inp file.  

4. Open  the H64020_r14_Residential.dxf and photo-grande-ile.jpg background 
layers from the same folder. 

5. Click the Open  button in the Map panel. 

6. Click on the Browse button and browse to the folder PCSWMM 
Exercises\K031\Initial. 

7. Select two files (holding the Ctrl key down) H64020_r14_Residential.dxf and photo-
grande-ile.jpg and click on the Open button.  

5.2 Creating a long term simulation 

In order to assess the LID performance it is helpful to run a continuous time series. For this 
example, an external 5 year continuous rainfall time series will be used. 

1. In the Project panel, click on Rain Gages to open the Raingage Editor. 

2. Click Add to create a new rain gage object, and change the name to 1991-1996. 

3. Set Rain Format to Intensity, and Time interval to 0:15. 

4. Change the Data source to be File and click on the ellipsis  , browse to PCSWMM 
Exercises\K031\Initial and select 6158733_1991-
1996_disaggregated_following_intensity.dat. 

5. In the Station ID box type in 6158733 and set the units to mm (even if working in US 
units). 

6. Check the Plot data file time series checkbox to preview the rainfall time series, as 
shown in the screenshot below. 

7. Click the OK button to save your changes and close the Raingage Editor. 
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8. Assign the 1991-1996 rain gage to all subcatchments. 

9. In the Layers panel, select Subcatchments. 

10. Press the Ctrl + A keys to select all of the subcatchments. 

11. In the Attributes panel set Rain gage to 1991-1996.  

12. Click on Simulation Options in the Project panel. 

13. Under the Dates tab, set the simulation options to be the same as shown in the 
following screen capture. 
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14. Open the Time Steps tab and change the Routing time step to 60 seconds if its not 
already. 

 

15. Click on the OK button to save your changes and close the Simulation 
Options editor. 

16. Click on the Run  button in the Project panel to run the model. 

5.3 Creating a LID Scenario 

Now that we have a baseline model run for the 5 year period, we can create a new 
scenario to model the LID devices. 

1. Create a duplicate scenario named Valleyfield LIDs and open the new project. 

2. Click the Plan  button in the Project panel, click on the Add  button and 
select Duplicate Current Project. 

3. Name the new scenario as Valleyfield LIDs and click Create. 

4. Click the Plan  button and open the new scenario by double-clicking on the 
new Valleyfield LIDs model. 

5. Choose to Save Project if prompted.  

6. Load the LIDs.shp background layer in the Map panel. 

7. Click the Open layer  button in the Map panel. 

8. Click on the Browse button and browse to the folder PCSWMM 
Exercises\K031\Initial and open the LIDs.SHP layer.  

9. In the Layers panel, drag the LIDs.SHP layer to the top of the list of layers. 
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10. Unlock the LIDs layer by clicking the Lock/Unlock  button. 

Note: The LIDs layer is a polygon layer that was created in order to represent the boulevard 
planters (see image below), however the LID analysis can be performed without physically 
adding any new layers to the PCSWMM interface, allowing both small scale and large 
infrastructure projects to be easily modeled using the SWMM5 LID extension.   

 

5.4 Defining LID attributes in LID toolbox 

Each type of LID control is represented by a different combination of vertical layers. For 
example, the parameters defined when modelling porous pavement include surface, 
pavement and storage layers, but when modelling a vegetative swale only the surface layer 
is to be defined. 

Parameter values for these layers can be obtained from the Reference tables on the 
PCSWMM support site, as well as through engineering drawings, and other hydrology 
literature values in textbooks and reports. The Reference tables include values for surface 
roughness, and soil infiltration parameters. In addition, the LID Control Editor reference article 
on the PCSWMM support site offers guidance for other LID parameters, such as clogging 
factors and drain coefficients. 

The table in the image indicates which combination of layers applies to each type of LID (x 
means required, o means optional). 

 

https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=31&ChapterNum=8&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=31&ChapterNum=8&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=31&ChapterNum=8&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=31&ChapterNum=8&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=31&ChapterNum=8&ScheduleID=134&WorkbookID=15&License=837662&Email=water@hydrosoft.co.kr&v=kjnyyjuAOkhsmcr1AVvJzS8rMUQ7nwi5TckpM%2bSmrtmMdEd0GuC%2boHzd9SVW0HgPFGqTV494go%2biqkB%2bTRfzpQgN6HGmIZLPMNih6MPMwJGOFgXVx5pCYgw7Z7rn2gXuQdgsE%2bLmYDs2TWujpjXUrcGm0T66az1oiMQkFo3uwaLu4uHyCyn%2fMvqtLLtEidqxzFZKyQhBEM4NrxScPFTdYJZTh0Z2Aq96wQIlPqugALmKjm%2fdn9ZRrrLk%2bLNaLSbPRDQqQ8%2bCgqTyMY6Do%2bmDXaIMKyBQWK8F6Kx6yx6pdR8%2foN7wi8DgCCC6ib8q%2bVXm
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In this example we will be modelling boulevard planters which would have similar properties 
as a bio-retention cell. 

A bio-retention cell consists of three layers: surface, soil and storage, along with 8 modeled 
processes. Below is a diagram illustrating the layers and component processes to be defined 
in the LID editor. 

Now we will define these three layer using PCSWMM. 

1. In the Project panel click on LID Controls to display the LID Control Editor. 

2. In the editor click Add to create a new LID object, and change the Name of the LID 
to Street_Planter. 

3. In the LID type drop down box select Bio-Retention Cell. 

The image below shows an example of a bio-retention cell with approximately 4 in|100 mm 
of surface storage courtesy of a weir outlet. This design is similar to the boulevard planters 
that will be modeled. 

 

Populate the values in the Surface tab as shown in the following screen capture. For this 
example each street planter will have a depth of 4 in|100 mm consisting of a vegetation 
fraction of 0.1 a Manning’s roughness of 0.3 and a slope of 0.25% (please note the screen 
shot shown is in SI units, US units will differ). 
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4. Click on the Soil tab in the LID control editor and populate the values as shown in 
the following screen capture. For this example each planter will have a soil surface 
thickness of 35 in|900 mm, a porosity of 0.44, a field capacity value of 0.11, a wilting 
point value of 0.05, a conductivity value of 1 in/hr|25 mm/hr, a conductivity slope 
of 7.5 and a suction head of 3.5 in|88.9 mm (please note the screen shot shown is in 
SI units, US units will differ). 

5. Click on the Storage tab in the LID control editor and populate the values as shown 
in the following screen capture. In this example each rain garden will have a 
storage thickness of 18 in|450 mm, with a void ratio of 0.75 and a conductivity 
of 0.24 in/hr|6 mm/hr (please note the screen shot shown is in SI units, US units will 
differ). 

 

6. Click on the Underdrain tab in the LID control editor and populate the values as 
shown in the following screen capture. In this model there will be no underdrain 
so all the attribute values will be set to zero. 
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7. Click OK to close the LID Control Editor (please note the screen shot shown is in US 
units, SI units will differ). 

 

5.5 Assigning subcatchment LIDs 

We will begin by specifying the LID details for each subcatchment: 

1. Select subcatchment S1 in the Map panel and in the Attributes panel click on 
the LID Controls item (please note the screen shot shown is in US units, SI units will 
differ). 

2. Click the ellipsis  button in the LID Control box to open the LID Usage Editor. 

3. The LID Control box allows the user to specify the type and number of LID controls 
located in a subcatchment, as well as other subcatchment specific LID parameters. 

4. In the LID Usage Editor click on the Add button. 

5. Assign the properties of the LIDs located on Subcatchment S1 as shown in the 
following screen capture. For S1 there are 4 boulevard-planters to be built, each 
planter will occupy an area of 1076 ft2|100 m2 and a top width of 10.8 ft|3.3 m and 
will be assumed to treat 100% of the impervious area (please note the screen shot 
shown is in SI units, US units will differ). 
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6. To specify the creation of a Detailed report file, click on the Browse button, 
navigate to PCSWMM exercises\K031\Initial\Valleyfield LIDs and save the LID 
report as S1-LIDs. 

7. Repeat step 3-4 for the remaining subcatchments, make sure each subcatchment 
has the correct number of planters as shown in the LIDs layer or using the table 
below. 

Note: there are no LIDs on subcatchments S5 and S9 so the LID Controls attribute in 
the Attributes panel should be left as 0. 

 

Adjust subcatchment area and flow width to compensate for LIDs. 

There are two approaches to placing LIDs: 

Placing one or more LIDs in an existing subcatchment that will displace an equal amount of 
non-LID area from the subcatchment. 

Creating a new subcatchment devoted entirely to a single LID and routing adjacent 
subcatchment runoff onto this LID subcatchment 

When LIDs are added to a subcatchment, the subcatchment's Area property is the total 
area of the subcatchment (both non-LID and LID portions) while the percent imperviousness 
and width parameters apply only to the non-LID portion. 

In this example we are adding LIDs to existing subcatchments so we will need to adjust the 
subcatchment percent imperviousness to compensate for the new LIDs. 
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1. Select Subcatchments from the list of tables in the Tables panel to display the 
subcatchment attributes. 

2. Change the subcatchment Imperv (%) values to match the New Imperv (%) values 
in the table below: 

 

3. Compute the Width attribute for the subcatchments, by dividing each 
subcatchment area by a approximate maximum length of overland flow. We’ll 
assume the average maximum length of overland flow is the sum of the average lot 
depth (115 ft | 35 m) plus the curb length between planters (135 ft | 41 m), which 
equals 250 ft | 76 m. 

4. Return to the Map panel by clicking on the Map tab. 

5. Click on the Tools  button and click on the Set Flow Length/Width tool (in the 
Subcatchments and Spatial Detail sections). 

6. Select Fixed length in the dialog and enter the computed length found in 
the Shape section in the Attributes panel, 250 ft | 76 m, in the textbox and ensure 
that Selected entities only is not checked. 

 

7. Click Apply to execute it. 

8. Click on the Run  button. 



63 

 

5.6 Comparing LID results 

1. Open the Graph panel. 

2. Click the Scenarios  button (next to Favorites) and toggle on the to-be model, 
then select Compare Scenarios. 

3. In the Time series manager expand it to show Links > Flow > C8. 

LID performance typically varies with rainfall event size. LIDs are typically more effective at 
reducing runoff for smaller events that are more frequent. 

Zoom into a smaller event close to the beginning of the simulation (see screenshot below). 
Notice the reduction in total stormwater runoff leaving the subdivision in the LIDs scenario 
compared to the original to-be model. 

 

4. Click the Full Extent  button to zoom out to the entire simulation hydrograph time 
series. 

5. Select a larger event close to the beginning of the simulation by holding down and 
dragging your mouse in the Graph panel (see screen shot below). 

 

Notice that there is a smaller percent reduction in both total flow and peak flow. For these 
large events the planters become saturated and are no longer able to store and infiltrate 
runoff as effectively. 
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5.7 (Optional) Comparing LID performance with LID clogging factor 

Over time LID performance may degrade due to clogging. Clogging is the reduction of 
infiltration capacity due mostly to fine particles. Clogging of LIDs in SWMM is modeled as a 
linear function of total infiltration. We will now create a new scenario to compare the 
performance of a LID with and without the addition of a clogging factor. 

1. Duplicate the current scenario in the same folder, name it Valleyfield LID clogging. 

2. With the Valleyfield LIDs model open, click on the Plan  button and click 

the Add  button and select Duplicate current scenario. 

3. Name the scenario Valleyfield LID clogging and click Create. 

4. Click on the Plan  button and click on Valleyfield LID clogging and click Open.  

5. In the new project, click on the LID Controls in the Project panel to open the LID 
Controls Editor. 

6. Open the Storage tab for the Street_Planter LID control. 

7. Change the value of the clogging factor to be 100. 

8. Click on the OK button to save your changes and exit the LID Controls Editor. 

9. Click on the Run  button in the Project panel to run the model. 

10. Compare scenario results for the flow in C8 again. 

11. Open the Graph panel. 

12. Click the Scenarios  button (next to Favorites) and toggle on the to-be model. 

13. Select the Compare Scenarios button. 

14. In the Time series manager expand it to show Links > Flow > C8 to compare the 
runoff hydrograph with and without clogging.  
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Zoom into a smaller event close to the beginning of the simulation (see screenshot below). 
Notice that the LID clogging factor has a minimal effect on the runoff response. This is 
because this event is at the beginning of the simulation period and there has been minimal 
clogging. 

Note: To add the time line to the bottom of the plot in the Graph panel click on the 
Properties button and select the Zoom Window to be On.    

 

Now select a period in the middle of the simulation and observe how over time the planters 
become clogged and are no longer able to reduce the runoff as much as when the LID was 
initially installed. 

 

5.8 (Optional) Opening the LID report 

1. Click on the Graph tab to open the Graph panel. 

2. Click on the Open  button and browse to PCSWMM 
exercises\K031\Initial\LIDs and select S1-LIDs. 

3. Expand S1>Storage Level> Street_planter and look at the changing storage depth 
over time. 

4. Open the LID reports from the other subcatchments and look at the reported time 
series. 
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6. Combined 1D-2D urban flood 
analysis 

European cities are commonly characterized as densely urbanized with small meandering 
streets and stone walls. Their drainage systems often consist of a mixture of open flow and 
underground conduits. One common stormwater problem in these cities is the frequent river 
flooding during heavy rains, due to urban development along the river flood plains in 
combination with walls acting as barriers to flood flows. 

In this exercise we will be modeling an area in France where a hospital is located. Because 
flooding is a major concern, there are strict regulations and new construction is only 
authorized if it does not exacerbate the risk of flooding. In this example, the hospital is 
planning building improvements that require more precise information on the flow behavior 
(flow velocities and water levels) to adopt the best strategy for flood mitigation. 

The objective of this study is to model the area with an assumed flow boundary condition at 
the upstream end of the river to compute potential flooding depths and flow velocities. 

 

6.1 Create model and define 2D layers 

When developing a 2D model in PCSWMM it is important to define the layers that will be 
used. The minimum input layers you need are a Bounding layer and a 2D nodes layer. A DEM 
is used to define the surface elevations of the modeled area (if DEM is not available 
PCSWMM assigns a uniform initial elevation of 0 m for all the 2D nodes). 

In this exercise we will be using 4 existing layers: bounding, obstructions, river centerline, and 
DEM. 

First, however, we need to create and setup the project: 

1. Create a new project called 2D Model in the PCSWMM 
Exercises\K001\Initial\ folder. 

2. Open PCSWMM and create a new project by clicking New from the list of options 
on the left side of the File tab. 

https://www.youtube.com/embed/g3ngnqAOmhU
https://www.youtube.com/embed/g3ngnqAOmhU
https://www.youtube.com/embed/g3ngnqAOmhU
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3. Select SWMM5 Project. 

4. Name the model 2D Model. 

5. Click on the Browse button and navigate to PCSWMM Exercises\K001\Initial\. 

6. Click the Create Project button to create the new project.  

This exercise is in SI units only so we need to set the units accordingly. If you are working 
outside of the US the units should already be set up to use SI units however if you are located 
in the US PCSWMM would have made the default US units. 

7. Change the model flow units to CMS. 

8. Click on the Simulation Options item from the Project panel. 

9. Under the General tab in the Miscellaneous section change the Flow units to 
be CMS. If you are completing this exercise outside of the US, the units should 
already be in CMS. Click OK to save changes.  

10. Set the coordinate system for the map and all layers to RGF93 v1 CC46. 

11. Click on the Menu button in the Map panel and select Coordinate system. 

12. Select Projected system from the list of coordinate systems and type in RGF93 in 
the Filter box and select RGF93 v1 CC46 from the filtered list. 

13. Toggle on the box to Apply to all layers and click OK. 

 

14. Click on Keep existing coordinate system option if asked if you want to make this 
the default coordinate system for new projects. 

15. Load the following background layers from the PCSWMM Exercises\K001\Initial\GIS 
layers folder: high resolution photo.png, Bounding-2D.SHP, Obstructions-2D.SHP, 
River centreline-2D.SHP, and w001001.adf. 

16. Click on the Open  button in the Map panel. 
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17. Click on the Open  button. 

18. Browse to PCSWMM Exercises\K001\Initial\GIS layers. 

19. Press the Ctrl key to select several different layers; high resolution photo.png, 
Bounding-2D.SHP, Obstructions-2D.SHP, River centreline-2D.SHP, and w001001.adf. 

20. Click on the Open button to open the selected layers. 

21. Click on the option to Set coordinate system to RGF93 v1 CC46 (3946).  

Now we will enable the 2D modeling component and define the 2D layers. 

22. Click on the File tab to open the PCSWMM backstage. 

23. Click on the 2D  button located in the backstage menu (under Professional 
Features). 

24. Check the Enable 2D modeling box to define the layers that will be used to set up 
the 2D model. 

25. In the Bounding layer drop-down menu select the previously opened Bounding - 
2D layer. 

26. In the Obstructions layer drop-down menu select the previously 
opened Obstructions - 2D layer. 

27. In the Centerline layer drop-down menu select the previously opened River 
centerline - 2D layer. 

28. In the DEM layer drop-down menu select the DEM file w001001. Do not close the 2D 
dialog. 

We need to create a new shape file layer to store the 2D nodes. 

29. Click on the New  button beside the 2D nodes layer drop-down menu. 

30. Navigate to PCSWMM Exercises\K001\Initial\GIS layers and create the layer with 
the default name 2D Nodes. Press Save. 
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Note: If you are using a PCSWMM version 7.5 or earlier, in the 2D editor, place a check next 
to Include velocity post-processing. 

31. Click OK to save your changes to the 2D setup and close the 2D editor. 

A message will appear asking if you want to create the missing fields in the boundary layer. 
Click Yes to create these fields. 

Rearrange the layers so the DEM layer (named "w001001") is positioned at the bottom (if it is 
not already) by dragging and dropping the layer in the Layers panel. 

32. Click the Save  button. 

Note: There are up to 8 layers that can be used in a 2D model. For more information about 
the 2D layers in PCSWMM please visit our Overview. 

6.2 Generate Points 

PCSWMM creates a 2D mesh using the 2D nodes layer to define the overland flow paths. A 
user can influence the point generation by specifying a mesh type and resolution in 
the Boundary layer polygon attributes. After the 2D nodes layer has been populated, points 
may be edited (moved, deleted, or added). For example, to add points, select the 2D 
nodes layer, click on the Add button in the Map panel and add points of specific interest (i.e. 
bank stations, depressions, etc.). 

In this model the Bounding – 2D layer consists of three polygons, one large one 
encompassing the hospital area and two smaller ones representing the river channels. We 
will define two different mesh types for these regions. A hexagonal mesh will be used to 
define the overland flooding area and a directional mesh will be generated to represent the 
river channels. 

1. Click on the Bounding – 2D layer in the Layer panel. Unlock the layer by right-
clicking on the layer and selecting Unlock. A message will be displayed asking if you 
want to unlock the layer or make a copy of the layer to edit. Select Unlock layer. 

Note: When working with scenarios, one should be careful in editing background layers that 
is used by multiple scenarios as the changes will apply to all scenarios. Thus PCSWMM 
displays a message box confirming your intent when unlocking a layer, giving you the option 
to create a copy of the layer. The 2D Cells layer is managed by PCSWMM for each project 
however other layers (bounding, 2D nodes, etc.) are background layers and can be used for 
more than one project. 

  

https://secure.chiwater.com/Workbook/Exercise.aspx?pcswmmcode=2&ChapterID=1&ChapterNum=12&ScheduleID=134&WorkbookID=15&License=837645&Email=jin@hydrosoft.co.kr&v=EqZc2R4A316goBtYmFrs2nHFMENZjh3pI28eFtjRhbaqUWIjSfEO08gP5e%2bufDH1Ha4E0DqSFUNb2XEgf%2fNQ08z0i2spVsAxbxXAnlqcwIFA9i3akOMxFyiICD3%2fguzh0ab00uXaOYXtxXgdaq0J4RJHdyu%2bU2SMxvCeTC40fyEto2OmIM9YCpYkgeOqBHfCsf96b0JCelRGGijKLKjeWEZ9wgi%2f9RCDMIcyhrsLhWGYYxBNz5eVw5%2fQESFS2PgCP91u80ZtK7GSTh0394jj8bay8MQ2VW2Di%2bBJcicUjPZP9O3E%2fhLecqIXfVFbbBKJ
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2. Select the larger polygon in the Bounding- 2D layer. 

 

3. In the Attributes panel specify the Style to be Hexagonal. 

Since the map units are in SI units the 2D mesh has to also be defined in SI units. We will model 
the flood area at a 5 m resolution. 

4. Next to Resolution type in 5 (m). 

5. Next to Roughness type in 0.033 representing the roughness of overland flow. 

6. Next to Edge select Yes from the drop-down menu. This has the same effect as the 
edge line layer. 

Leave the rest of the attributes as shown. 

 

We will now define a directional mesh for the smaller bounding polygons that encompass the 
open channels. To account for the greater variation in elevation along a cross-section, we 
will use a finer mesh resolution perpendicular to the mesh direction (i.e. a smaller 
mesh Width). 
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7. Select the two smaller boundary polygons by selecting one, holding down 
the Ctrl key and then selecting the other. 

8. In the Attributes panel specify the Style to be Directional. 

9. Next to Resolution enter 3 (m). 

10. Next to Roughness type in 0.04 (the channel is heavily vegetated). 

11. Next to Edge select Yes from the drop-down menu (this creates a clean edge 
between the two mesh types, suitable for delineating sudden topological changes 
such as overbank stations). 

 

12. Click the Save  button to save your project. 

 

Now we can generate center points that will be used to create the mesh. These points are 
created on the 2D Nodes layer. 
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13. Click on the Tools  button in the Map panel. 

14. Select 2D modeling from the list of tool categories. 

15. Select the Generate points tool from the 2D modeling list. 

16. Ensure that the Points (2D Nodes), Bounding, Obstruction and Center line layers are 
correctly identified. Obstructions for this exercise include buildings as well as several 
walls in the area. The estimated number of points should appear at the bottom of 
the Generate points window. 

 

17. Click OK to generate the points. If you are unable to see the points after creating 
them toggle on the 2D Nodes layer in the Layers panel. 

 

6.3 Create diverging/converging locations in stream 

In this example, the two sections identified as being a directional river segment are 
connected with a culvert running under the parking lot. Also, inflow to the model will occur 
at the upstream end of the westerly directional river segment, and a downstream culvert will 
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drain water from the east side of the easterly directional river segment. In order to connect 
the sectional meshes to upstream and downstream culverts, we need to create a 2D node 
point to force the mesh to converge. 

Zoom into the upstream location of the westerly directional bounding polygon (NW 
boundary of the project site), as shown in the screenshot. 

 

1. Select the 2D Nodes layer in the Layers panel. 

2. Unlock the layer (if locked) by right-clicking on the layer and selecting Unlock. 

3. Click on the Add button in the Map panel’s toolbar. 

4. Put a point in the furthest upstream location in the polygon by clicking on the 
location in the map (see illustration below for guidance). 

5. Click on the Select  button to get out of Add mode. 

 

6. Zoom into the downstream location of the same directional bounding polygon. 

7. Ensure there is a single point in the furthest downstream location; you may need to 
move or delete points. To move a point double click on the point and drag it to the 
new location. 
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Move to the upstream location of the second (easterly) directional bounding polygon and 
remove points so that there is a single point in the upstream location. 

 

Finally move to the downstream location in the second directional polygon and add or 
remove points to make a single point. 

 



75 

 

6.4 Create Mesh 

Now that we have established the points for the 2D cells, we can create the 2D mesh. When 
generating the mesh the model will sample elevations from the DEM layer at the locations of 
the 2D nodes. The first thing we will do is turn off the option to Show link arrows, this will keep 
the mesh from not looking too cluttered. 

1. Turn off the Show link arrows option in the Preferences dialog. 

2. Click on the Menu  button in the Map panel and select Preferences. 

3. Under the Map tab toggle off Show link arrows. 

 

We will now create our 2D mesh. 

4. Click on the Tools  button, in the Map panel, and select 2D modeling. 

5. Select Create Mesh from the 2D modeling sub menu. 

6. Ensure that the Bounding, Obstruction, and 2D Nodes layers are defined in 
the Create 2D mesh window. 

7. Click OK to generate the mesh. 
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PCSWMM will now automatically create the 2D mesh. This should only take a couple of 
seconds. 

 

Once the mesh generation is completed a report will appear. You can close the report once 
you have read it. After mesh generation, the 2D mesh is rendered to display the cells as well 
as the links and nodes of the mesh. 

8. Click on the Close button to close the Operation Report. 

9. In the Layers Panel uncheck the 2D Nodes layer to hide it (it is no longer needed). 

10. Click on the Save  button to save the project. 
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11. Link arrows can be turned back to see the direction of 2D links using 
the Preferences dialog. 

12. Turn on the Show link arrows option for 1D and 2D links in the Preferences dialog. 

13. Click Menu > Preferences. 

14. In the Map tab, check the option to Show link arrows if not checked already. 

15. Toggle on the option to Include 2D links. 

16. Click OK. 

 

Zoom into the mesh to see the link arrows. 

Repeat step 9, this time turning off the arrows to avoid crowding the screen. 

We will now check the elevations assigned to the 2D cells through a map rendering. 
The Render 2D network tool allows you to quickly set the layer properties for a number of 2D 
layers to one of the default renderings. 

17. Click on the Tools  button and select 2D modeling. 

18. Select Render 2D network from the 2D modeling sub menu. 

19. Select Show Cell Elevations. Note how the color changes with the topography of 
the project area. 
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Let’s return to a map rendering that displays the mesh. 

20. Click on the Tools  button and select 2D modeling. 

21. Select Render 2D network from the 2D modeling sub menu. 

22. Select Show Mesh. 

23. Now uncheck the 2D cells layer in the Layers panel to hide it. 

Zoom into the smaller bounding polygons and notice how the directional mesh is different 
from the hexagonal mesh shape in the larger polygon. 

Note: that if you want to improve the layout of the mesh, you can use an iterative approach 
of adding/moving/deleting points in the 2D nodes layer and regenerate the mesh with 
the Create Mesh tool. The Create Mesh tool will replace existing 2D entities in the model (2D 
cells, nodes and conduits) and reconnect the mesh to any existing 1D entities or 1D-2D links. 

6.5 Add 1D culvert 

We still need to add the culvert that links the two directional meshes under the hospital 
parking lot. 

1. Select the Conduits layer from the Layers panel. 

2. Click on the Add  button. 

3. Click on a mesh junction closest to the border of the upstream boundary and then 
on a junction close to the border of the downstream boundary (i.e. from northwest 
to southeast) to connect the upstream river segment to the downstream river 
segment (see the yellow conduit in the figure below). 
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4. Click the No  button if asked if you would like to turn auto-length on. For 2D 
models, we do not want PCSWMM to determine conduits lengths from the map (the 
2D mesh generator automatically sets appropriate conduit lengths for the 2D 
mesh). 

 

Now we need to define the culvert attributes. For this model, the conduit just to link the two 
river segments is not one of the culvert shapes so the culvert shape will be defined using the 
custom culvert editor. 

5. Click on the Select  button to get out of Add mode. 

6. Change the culvert length to 77 m and roughness to 0.033. 

7. Click in the Cross-section attribute and click on the Ellipsis  button. 

8. Select Closed Rectangular from the cross-section editor. 

9. Change the Max. depth (m) to 1.5 m. 

10. Change the Bottom width (m) to 5 m. 

11. Click the OK button. 
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6.6 Create an outfall 

An outfall is assigned at the downstream end of the river to define the model’s downstream 
boundary condition. It will be placed at the exit of a culvert draining the downstream 
directional river segment. 

1. Select the Outfalls layer from the Layers panel. The layer will appear grayed out as 
there are currently no Outfalls in the model. 

2. Click on the Add  button. 

3. Click on the eastern edge of the project area downstream of the second 
directional river segment to add an Outfall (see screenshot for location). 

 

4. Change the name of the Outfall to 2DOut. 

5. In the Attributes panel set the Invert El. (m) to 338.15 m. 

6. In the Attributes panel set the Rim Elev. (m) to 348.15 m. 

7. Change the Type to FREE. 

 

8. Select Conduits layer from the Layers panel. 

9. Click on the Add  button. 
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10. Click on the furthest downstream junction in the easterly directional river segment 
and then click on the Outfall to add a conduit between the two nodes. 

11. Click the No  button if asked if you would like to turn auto-length on. 

 

12. In the Attributes panel, change the conduit’s length to 12 m. 

13. Set the Roughness to be 0.033. 

14. Change the conduit cross-section to a Closed Rectangular shape with a Max 
Depth of 1.5 m and Bottom width of 5. 

15. Click on the Cross-Section attribute box and select the Ellipsis  button. 

16. Select the Closed Rectangular culvert shape. 

17. Set the Max depth to 1.5 m. 

18. Set the Bottom width to 5 m. 

19. Click OK to close the Cross-sectional Editor.  

20. Click on the Select  button to exit the Add mode. 

6.7 Assign an inflow time series 

1. Create a new object in the Time Series Editor called 2D_Inflow. 

2. Click on the downward arrow in the Project panel and select the Time Series item. It 
will appear grayed out as there are currently no time series defined. 

3. Click on the Add button. 

Name the new time series 2D_Inflow.  

4. Click on the Load button and browse to PCSWMM Exercises\K001\Initial\Time 
series and select 2D Inflow Time series.dat and click Open. The design hydrograph 
will be displayed in the Time Series Editor. 
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5. Click OK to close the Time Series Editor. 

 

Note: there are multiple ways to assign an inflow boundary condition to a 2D model: 1. 
Assign a water surface elevation time series to one or more outfall(s) and connect the 
outfall(s) to the 2D mesh using a conduit. The downstream boundary layer and associated 
tool can be used to efficiently do this for a non-point boundary condition. 2. Apportion a flow 
time series to one or more 2D junctions directly in the junction’s Time series attribute. In this 
case, the inflow can be apportioned to multiple nodes by setting the node’s time series 
Factor attribute to 1/n, where n is the number of nodes the inflow is to be apportioned. 

We now want to assign the inflow to the furthest upstream junction in the river boundary 
polygons. In this case, we can assign the entire inflow to a single junction in the 2D mesh. 

6. Click on the Junctions layer from the Layers panel. 

7. Select the furthest upstream junction in the upper river boundary polygon (as shown 
in the screenshot). 

 

8. Assign the 2D_Inflow time series to the selected junction as an inflow. 

9. In the Attributes panel, click in the Time Series box and click on the Ellipis  button. 
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10. The Time Series editor will open, allowing you to specify the time series. 

11. Select the desired inflow time series and click on the Assign to Junction button to 
assign it to the selected junction. 

 

6.8 Run a simulation 

We won’t assign any initial conditions: the model will assume to start as dry bed. SWMM5 is 
able to transition a 2D mesh from a dry bed to a wet one without model stability issues. Let’s 
set the simulation options and run the model. 

1. Set the simulation period to match 2D_inflow and change the simulation duration to 
12 hours. 

2. Click on Simulation Options from the Project panel. 

3. Click on the Dates tab and select 2D_Inflow under the Set simulation period from 
time series drop-down menu. This allows us to quickly set the simulation period to 
match the input time series. 

4. Set the Duration to 12 (h).  

5. Change the reporting time step to 30 seconds, and the routing time step to 0.5 
seconds. 

6. Still in the Simulation Options, click on the Time Steps tab and change 
the Reporting time step to be 00:00:30 (i.e. 30 seconds) 

7. Change the Routing time step to be 0.5 s.  

8. Set PCSWMM to ignore the inertial terms and use the maximum number of threads 
available. 

9. Still in the Simulation Options, click on the Dynamic Wave Tab. Under Inertial 
terms select Ignore. 

10. Under Number of Threads choose the maximum number available. 

11. Click OK to close the Simulation Options editor.  
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12. Click on the Run  button to run a simulation. It should take between 4 - 8 minutes 
to run, depending on the computational speed of your computer. 

13. You should receive the message "We recommend a minimum surface area of 0.1 
m2 or less for 2D projects", select the option to "Change the minimum surface area". 

14. When the Simulation Options window opens, change the Minimum nodal surface 
area to 0.1 (Square Meters). 

15. Click OK to save your changes 

 

16. Click on the Run  button to run a simulation. 

You may receive a message saying that we recommend not reporting the input summary for 
2D projects, click on the Continue anyway button. 

6.9 Render model to show maximum water surface elevation 

1. Click on the Tools  button and select 2D modeling. 

2. Select Render 2D network from the 2D modeling sub menu. 

3. Select Show Cell Max. Depths. 
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Your model should look something like this. 

 

6.10 Add downstream boundary condition 

You may have noticed when the model was rendered to the maximum water surface 
elevation that water was starting to buildup on the boundary of the 2D model. This is 
because the only way water can leave the model is through the outfall. To prevent this from 
happening we can make a downstream boundary condition allowing water to leave the 
boundary area through outfalls automatically generated using the Create Boundary 
Outfalls tool. This tool takes a user-drawn line and creates outfalls at the conduits crossing the 
line. In this example we have already created the boundary outfall line. 
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1. Add a 2D downstream layer called DS boundary condition - 2D.SHP from 
the \Initial\GIS layers folder. 

2. Click on File and select  2D from the options on the left side of the screen. 

3. Click on the Open button beside the Downstream layer drop-down menu and 
navigate to PCSWMM Exercises\K001\Initial\GIS layers and select DS boundary 
condition - 2D.SHP. 

4. Click Open and then select OK.  

You will notice that there are 6 green lines in the downstream boundary layer. These lines are 
indicating the locations where we want to add our downstream boundary condition. 

5. Click on the Tools  button and select 2D modeling from the list of tool options. 

6. Select the Create Boundary Outfalls from the list of tools. 

7. Select DS boundary condition - 2D from the Downstream layer drop-down menu. 

 

8. Click on the OK button. 

A message will appear saying the number of outfalls and connected conduits were created. 
The 2D outfalls are set to be type = Normal meaning they are assigned the sampled ground 
elevation. To use Normal outfalls in a model it is important that the link connecting the model 
to the outfall has a positive slope. To ensure this in our model we will adjust the slopes of the 
conduits with invert slopes. 

9. Select all outfalls with the tag 2D_Out. 

10. Click on the Find  button and choose Select by Query. 

11. Change the Layer to be Outfalls, the Attribute to be Tag, the Operator to be =, and 
the Value to be 2D_OUT. 
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12. Click on the Select button then the Close button. 

13. Click on the Find  button and choose Select connected > Immediate Upstream. 

14. Click on the Conduits layer, the Attribute panel will indicate that you have multiple 
conduits selected. 

Now we want to identify the links that have negative slopes. To do this: 

15. Click on the Find button and choose Select by Query. 

16. Set the Layer to Conduits, Attribute to Slope, Operator to <=, and Value to 0. 

17. Click Select within to limit the search to include only the selected conduits and 
click Close. 

 

We now want to fix the inverse slopes using the set slope tool. 

18. With the conduits still selected, click on the Tools  button. 

19. In the Conduits section, click on the Set slope tool located at the bottom of the list. 
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20. Set the slope to 0.2%, uncheck Preserve node rim elevations, Raise upstream nodes’ 
invert elevation and Apply to flatter conduits only, leave the Selected conduits 
only checked. 

 

21. Click on the Analyze… button. 

22. Click Apply and Close. 

You can now re-run your model and render the 2D cells on Maximum depth and see how 
the flooding has changed as a result of the added downstream boundary layer. 

 

The following chapter will review some of the post-processing and analysis tools available in 
PCSWMM for reviewing the results of a 2D simulation. 
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6.11 Troubleshooting 

If you added a downstream layer to your model and after you ran and rendered the cells 
everything shows in red: The downstream layer uses free outfalls which does not permit the 
upstream conduit to have a slope less than or equal to zero. If you are having this issue you 
likely used the less than < symbol and not the <= symbol when selecting the upstream 
conduits. 

If you have a high continuity error it is likely caused by the contraction and expansion nodes 
not being defined correctly. 
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7. Dual-drainage integrated 1D-2D 
flood modeling with obstructions 

The following example illustrates a case study in an urban area in Southern California. This 
model represents a 2-square mile watershed area, and consists of 6 miles of storm drains, 6 
detention basins, 2000 houses and structures and 20 miles of streets and roadways. In this 
exercise we will be starting with a 1D model representing the underground stormwater pipes, 
from there we will be adding a 2D overland mesh to represent the street and gutter flow. 

 

7.1 Open existing 1D model 

We will begin by opening the 1D model. 

1. Unpackage 1D Simi Valley model.pcz from the PCSWMM 
Exercises/K003/Initial folder. 

2. Open PCSWMM and click on the Open  button. 

3. Browse to PCSWMM Exercises/K003/Initial and select 1D Simi Valley model.pcz and 
click Open. 

4. Unpackage the model to PCSWMM Exercises/K003/Initial/Model 

5. Click OK.  

6. Load the DEM, w001001.adf, from the PCSWMM Exercises/K003/Initial/GIS 
layers/erringer_1ft folder. 

7. Click on the Open  button and then the Open  button. 

8. Navigate to PCSWMM Exercises/K003/Initial/GIS layers/erringer_1ft and 
select w001001.adf. and click Open. 

9. In the Layers panel, click on the DEM layer (w001001).  

https://www.youtube.com/embed/DmBOKA331Zw
https://www.youtube.com/embed/DmBOKA331Zw
https://www.youtube.com/embed/DmBOKA331Zw
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10. Click on the Render  button and look at the coordinate system. If you click on 
other layers, you will notice it is a different coordinate system. 

When a DEM is used in a 2D model, the coordinate system must be the same as other layers. 
DEMs and other layers can be projected directly in PCSWMM. 

11. Reproject the DEM from its current system to NAD83 California zone 5ft US. Rename 
it "DEM". 

12. Click on the Alter  button and choose Reproject. The current coordinate system 
will already be set in the From section. 

13. In the To section, click on the Set button. 

14. In the Coordinate system editor, click on the Projected system section. 

15. Type in NAD83 California. 

16. From the results choose NAD83 California zone 5ft US and click OK. 

 

17. Click on the Save as button and name the new file "DEM." 

18. Click Close. The new DEM will be loaded in the Layers panel. 

19. In the Layers panel, right-click on the w001001 file and then Close. 

20. Click the Save  button to save your project. 

7.2 Create 2D layers 

When developing a 2D model in PCSWMM it is important to define the layers that will be 
used. In this exercise we will be using five 2D layers: bounding, 2D nodes, obstruction, 
downstream, and a DEM layer. We will start by creating and defining the 2D layers we will 
need for the model. 

1. In the File panel, select the2D  button near the bottom of the list. 
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2. Toggle on the Enable 2D modeling box. 

3. Click on the Open  button beside the Bounding layer drop-down menu and 
browse to PCSWMM Exercises/K003/Initial/GIS layers. 

4. Select Boundary.SHP and click on the Open button. 

5. Click on the New  button beside the 2D nodes layer drop-down menu. 

6. Navigate to PCSWMM Exercises/K003/Initial/GIS layers and click on the Save button 
to save the layer with the default name (i.e. 2D Nodes). 

7. Click on the Open  button beside the Obstructions layer drop-down menu and 
navigate to PCSWMM Exercises/K003/Initial/GIS layers and select Buildings footprint 
layer.SHP and click on the Open button. 

8. Click on the New  button beside the Downstream layer drop-down menu. 

9. Navigate to PCSWMM Exercises/K003/Initial/GIS layers and click on the Save button 
to save the layer with the default name. 

10. In the DEM layer drop-down menu, select the new DEM file that was just created. 

11. Click Yes if asked if you want to set the map coordinate system to NAD83 California 
zone 5ft US. 

 

12. Click on the OK button to save your 2D settings and close the 2D setup dialog. 

13. Click the Save  button to save your project. 

7.3 Create second bounding polygon based on roads layer 

In this example, a different Manning's roughness value will be assigned for the roads 
compared to the areas around the buildings. This can be done with two bounding polygons, 
the first being the overall study area and the second just the roadways. We have already 
defined the overall bounding polygon however we still need to create a bounding polygon 
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representing the roads. To do this we will use an existing roads layer and use the Split tool to 
crop the roads layer to the overall boundary layer. 

1. In the Layers panel, uncheck the DEM layer to improve the responsiveness of 
the Map panel. 

2. Load the Roads layer.shp file from the PCSWMM Exercises/K003/Initial/GIS 
layers folder. 

3. In the Map panel click on the Open layer  button. 

4. In the Layer browser click on the Open  button. 

5. Navigate to PCSWMM Exercises/K003/Initial/GIS layers and open the Roads 
layer.SHP.  

6. Reproject "Roads layer" from its current system to NAD83 California zone 5ft US and 
save it as "Roads". Close the previous "Roads layer" file. 

7. Right click on the Roads layer and click on the Unlock option to unlock the layer. 

8. Click on the Roads layer polygon and press Ctrl+A to select all the roads. 

 

9. Click on the Edit  button in the Map panel. Select Split . 

10. In split mode, choose After active point , and then click around the bounding 
polygon drawing a cut line just outside of the boundary. The following screenshot 
highlights the pathway to be followed with the split tool in yellow. 

11. Click on the Split  button in the sub-toolbar to split the selected roads layer 
polygon. It may take a few seconds to complete the split operation 
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12. Delete portions of the Roads layer outside of the split area. 

13. Click on the area of the roadway layer inside the overall boundary. 

14. Click on the Find  button and choose Invert selection. 

15. Click on the Delete  button to remove them from the roads layer. 

 

Now we are going to add the edited roads polygon as a bounding polygon. 

1. Copy and paste the Roads layer shape into the Boundary layer. 

2. Click on the Roads layer in the Layers manager and click on the remaining roads 
polygon in the map to select it. 

3. Click on the Copy  button. 

4. Select the Boundary layer from the list of layers. 

5. Click on the Lock  button and select to Unlock the layer. 
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6. Click on the Paste  button to paste the Roads layer into the Boundary layer.  

7. Finally, let’s close the Roads layer. 

8. In the Layer manager click on the Roads layer and click on the Close  button in 
the Map panel toolbar to close the layer. 

9. Click No when asked if you want to save the unsaved work. This way you will still 
have the original roads layer intact. 

 

7.4 Define bounding polygon attributes 

We will now assign the resolution and Manning's roughness coefficients for the bounding 
polygons. 

1. Click on the Boundary layer in the Layers panel and select the overall boundary 
polygon in the map by clicking on it. 

2. Leave the Style set as Hexagonal, set the Resolution to 50 ft and change 
the Roughness to be 0.085. Leave the Edge attribute set to No. 

 

1. Select the boundary polygon marking the roads in the Boundary layer. 
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2. Leave the Style set as Hexagonal, set the Resolution to 20 ft and change 
the Roughness to be 0.025. Change the Edge attribute set to Yes, this will cut the 2D 
cells cleanly at the curb. 

 

7.5 Create points in 2D nodes layer 

Depending on the number of obstructions and the complexity of your bounding polygons 
the 2D nodes may take some time to generate. For this particular exercise there are ~1000 
buildings in the obstruction layer and the roadway bounding polygon adds complexity, so for 
the sake of time we will be providing the points for the 2D nodes layer. 

1. In the Map panel click on the Tools  button. 

2. Click on the 2D modeling section from the list of tool categories. 

3. Select Generate points from the list of 2D tools. 

4. Check that the layers have been correctly assigned for 2D node creation as shown 
in the screenshot. The number of points to be created will be displayed and should 
be approximately 12,000. 

 

5. Click OK. It may take a few minutes for the 2D Nodes to be generated. 

6. The new layer will automatically be added to the Layers panel and the Map 
panel. There should now be approximately 12,000 points in the 2D Nodes layer 
within the 2D model domain identified by the Bounding layers. 
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7.6 Generate 2D overland mesh 

1. Click on the Tools  button and select 2D modeling from the list of tool categories. 

2. Select Create mesh from the list of 2D tools. 

3. Ensure the layers have been correctly assigned (see screenshot) and click on 
the OK button. It may take around 10 minutes to generate the mesh. 

 

7.7 Identify 1D nodes to be connected to the 2D overland mesh 

The next step is to connect the 1D portion of the model to the 2D overland mesh to connect 
the major and minor systems of our dual drainage model. To do this we need to first identify 
where the 1D connection points are and mark them by adding a Connect2D tag. Normally 
you would do this manually, however for this exercise we have identified the connection 
points using a user defined attribute. 

1. Uncheck the 2D Nodes layer in the Layer panel. 



98 

 

2. Select all junctions with the attribute CONNECTION set to YES. 

3. In the Map panel click on the Find  button and choose Select by Query. 

4. Set the Layer to be Junctions, the Attribute to be CONNECTION, the Operator to 
be = and the Value to be YES. 

 

5. Click on the Select button, there should be 24 selected junctions. 

6. Click on the Close button to close the Select by Query tool. 

7. With the junctions still selected, in the Attributes panel type Connect2D in 
the Tag attribute. 

 

Now let’s connect these junctions to the 2D mesh: 

1. Click on the Tools  button, select 2D modeling from the list of tool options and 
select Connect 1D to 2D. 

2. Select Connect to 1D nodes directly and click OK. 
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Note: For 2D dual drainage models, it is recommended to use bottom orifices to represent 
catch-basins. However, for this exercise, the catch-basin details were not available so direct 
connections were used. 

7.8 Create downstream layer 

Currently the only way for water to leave the system is through the outfall at the north end of 
the 1D drainage system. In order to allow surface flow to exit the model across the 2D 
boundary, we need to add a downstream boundary line. In the steps below we will draw the 
boundary condition line in the DS boundary condition layer. 

1. Click on the DS boundary condition layer in the Layer manager to select it. 

2. Note: If the DS...  layer is locked, unlock it.   

3. Click on the Add  button. 

Draw a line across the west side of the 2D mesh, just inside the boundary area by first clicking 
on the desired starting position for the line, and then clicking on the desired ending position 
for the line. The line should run the full length of the west side of the mesh as shown by the 
yellow dashed line. 

 

1. Click on the Commit changes button or press the Enter key to complete the 
creation of the line. 

2. Click on the Tools  button and select the 2D modeling from the list of tool 
categories. 

3. Select the Create Boundary Outfalls tool. 

4. Ensure the Downstream layer has been assigned to DS boundary condition, the DEM 
layer is selected and click OK. 
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5. Click Close to close the Create Boundary Outfalls report. 

6. Click on the Zoom  button and zoom into a section where the DS boundary 
condition was drawn. Make sure the 2D network is rendered to Show Mesh. Notice 
how there are now approximately 90 outfalls added to the mesh. 

 

7. Zoom back out to the full extent of the SWMM model (click on the Extent  button 
and select SWMM model and then View). 

7.9 Set simulation options 

We will now set the simulation options to run the integrated 1D-2D model. When setting the 
simulation options we recommend you change the Inertial terms to Ignore (SWMM will use a 
Diffusive Wave routing method) and set the Minimum surface area to 0.1 ft. This will reduce 
the continuity error and provide a more reasonable estimate of the extent of flooding. 

1. Click on the Simulation Options item from the Project panel and select the Dynamic 
Wave tab. 

2. Set the Inertial terms option to Ignore. 
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3. In the Minimum surface area box, type in 0.1. 

4. Click on the OK button to close the Simulation Options editor. 

 

Since this model would take ~1 hour to run the full 24 hour simulation, we will change the 
simulation time to only include the peak of the event. Hydrology is not simulated in this 
model; instead, inflow hydrographs are added directly to the 1D hydraulic model nodes. 

5. Click on the Time Series item in the Project panel to show the inflow hydrographs 
being used as input into the model. 

Note where the peak of the event is for the inflow time series (from 18:00 to 20:00). 

 

6. Click OK to close the Time Series editor. 

7. Click on the Simulation Options item in the Project panel. 

8. Click on the Dates tab to change the date of the simulation. 

9. Change the Start analysis on time to be 18:00:00, change the Duration to be 2 h 
and then click OK. 
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7.10 Run the model and visualize results 

The model is now ready to run. 

1. Click on the Run  button to run the model. 

2. When a warning message about the routing time step appears, click on the option 
to Continue anyway. 

It may take between 10-15 minutes to run the model depending on the speed of your 
computer. 

Once the run is complete, check that the routing continuity error is less than 5%. If it is 
between 3-5% it is likely a result of the model being run for such a small duration of the event. 

We will now render our 2D cells to show the maximum extent of flooding. 

Once the model is done running, uncheck the Boundary layer in the Layers panel. 

Render the 2D mesh to show cell max. depths. 

3. Click on the Tools  button and select 2D modeling from the list of tool 
categories. 

4. Select Render 2D network and select Show Cell Max Depths. 
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You can also render the model based on Maximum Cell Max. Velocity and animate the 2D 

cells using the Play  button in the Map panel. 

7.11 Adding an elevations layer (Optional) 

You may have noticed when the model was rendered to show the maximum depth, there is 
a section running from north to south showing odd rendering where the depths of water 
notably vary between adjacent cells. This is caused by the cell elevation being sampled from 
the center location of the 2D cell. In this case it is suggested that an elevation layer is used to 
sample the DEM at a higher resolution and from there assign the average elevation in the 
cell as the cell elevation. 

1. Duplicate the project to create and then open a new scenario called 2D Simi 
model with elevations. 

2. Click on the Plan  button and click on the Add  button. 

3. Select Duplicate Current Project and name the project 2D Simi model with 
elevations. 

4. Open the newly created scenario.  

5. Click on File and select 2D from the options on the left side of the screen. 

6. Click on the New button beside the Elevation layer drop-down menu. 

7. Navigate to PCSWMM Exercises/K003/Initial/GIS layers and click Save to save the 
file with the default file name (i.e. Elevations.SHP). 

8. Click OK to close the 2D window. 

9. Select the Boundary layer from the list of layers and unlock the layer. 

10. Click on the overall boundary polygon. 

11. Click on the Tools  button. 

12. In the 2D modeling section, select Generate Points. 
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13. In the Points layer drop-down menu, specify Elevations. 

14. Ensure that the Selected polygons only box is checked and the DEM layer has been 
assigned. 

15. Click OK. 

Now we want to regenerate the 2D overland mesh 

16. Click on File and select 2D from the options on the left side of the screen. 

17. Click on the Tools  button. 

18. In the 2D modeling section, select Create Mesh. 

19. Under Invert elevation attribute from, select points layer. Select Elevations from the 
drop-down menu. 

20. Ensure the other 2D layers are properly assigned and click OK. 

 

Because we are using direct connections we need to reconnect the model. Had we used 
orifice connections the orifices would have automatically been recreated. 

21. Click on the Tools  button. 

22. In the 2D modeling section, select Connect 1D to 2D. 

23. Choose to Connect to 1D nodes directly. 

24. Click OK. 

25. Click on the Run  button to run your model. 

When a warning message about the routing time step appears, click on the option 
to Continue anyway. 
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It may take 10-15 minutes to run the model. Once the run is complete, note how the 
rendering in the one area has improved. As an additional step create a hydrograph layer in 
the backstage 2D options and compare the flow across this channel. 
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